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Prerequisites 

Intended Audience 

EFILive Customers using the V8 Scan and Tune Tool software. 

Computer Knowledge 

It is expected that readers have a basic understanding of: 

 The Windows operating system; 

 Starting and using Windows applications; 

 Navigating folders using Windows Explorer. 

Tuning Knowledge 

It is expected that readers have a basic understanding of: 

 Electronic Fuel Injection. 

 On Board Diagnostics. 
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Introduction 

What is EFILive? 

EFILive is tuning software and hardware - it is not a tune.  Together the software 
and hardware give users the tools to write tunes.  EFILive does not provide tune 
files, tuning advice or support, but do provide software support and hardware 
support. 

What is EFILive DSP4? 

EFILive's DSP4 custom operating systems for Duramax controllers allows 
customers to be able to switch 'on the fly' between multiple tunes, all stored in the 
ECM's flash memory 

Having multiple tunes instantly accessible means changing tunes to suit different 
driving conditions no longer requires the ECM to be reflashed each time you 
choose to run a different tune. (E.g. racing, towing, or power limiting.)  Simply build 
multiple tunes to fill the DSP4 slots, flash the ECM once and then select your 
desired tune through via a hardwired switch at any time. 

The ECM can be returned to GM factory condition at any time by reflashing a 
stock GM Operating System and calibration into the ECM using the Full Flash 
option. 

Software Version Overview 

This version of the Duramax E98 DSP4 User Guide migrates all processes to 
EFILive V8 Scan and Tune software.  Functionality is still available in V7.5 
software, however software support and bug fixes will cease in 2021. 

FlashScan/AutoCal V3 and AutoCal V2 are not compatible with V7 software.  V7 
functions are only supported by FlashScan V2.  The following is a brief view of the 
activities that are performed with the different software versions: 

Feature V7 V8 

Scanning   

OBDII Diagnostics   

Reading   

Flashing   

Tune Editing   

VIN License Management   

Firmware Management   
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To upgrade to DSP4 exclusively in EFILive V8 Scan and Tune software you must 
be running the following (or higher) software versions. 

1. EFILive V8.3.8 or later. 
2. FlashScan V3 / AutoCal V3 Firmware – V3.00.068. 
3. FlashScan V2 / AutoCal V2 Firmware - V2.08.177. 

The latest software versions are available for download from EFILive's website. 
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DSP4 Upgrade 

DSP4 Upgrade Checklist 

DSP4 upgrades are only available on specific factory operating systems.  Typically 
these are based on the latest factory update (at time of development).  If you have 
a truck that has an OS not listed below, you will need to upgrade your base file 
first.   

Supported DSP4 operating systems are listed in the table below.  These were the 
latest factory updates as of 2019; released 4 years after this ECM type was 
introduced. No further EFILive development is scheduled for Duramax platforms. 

Operating System # 

55484589 55503875 

55488069 55503892 

55491998 55504430 

55493455 55508116 

55500370 55597308 

Upgrade Operating System to DSP4 

1. Open V8 Scan and Tune software and your stock tune file. 
2. Navigate to [F5: Edit]. 
3. Expand the Engine Operation -> Operating System Patches Folder and select 

DSP4 Custom Operating System. 
4. Select the [Apply Upgrade] button. 
5. Select [Yes] to the “This operation cannot be undone, continue?” dialog box.  
6. A message indicating “Upgrade applied successfully.” will now display.   

   
7. Save the file with a new name using, File > Save As. As an example; 

'My Truck Base DSP4 Conversion.ctz’. 
8. Close the tune file. 
9. In the EFILive V8 Scan and Tune Recent Items entries for the stock tune and 

your upgraded DSP4 tune will be listed.  Confirm that the operating system 
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number on the base file is different to the upgraded DSP4 converted file. 

  
10. Reopen the tune file that was converted. 
11. Edit the values on your individual tunes, and [Save] the changes to your tune file. 
12. Flash the DSP4 tune into your ECM.  Refer to pass-thru flashing, FlashScan 

V3/AutoCal V3 flashing or FlashScan V2 flashing for further instructions. 

Supported Switching Methods 

EFILive’s DSP4 custom operating system can be switched using 
FlashScan/AutoCal V3, FlashScan/AutoCal V2, hardwired switch or the EFILive 
Android App.   

Important DSP4 Parameters and Tables 

Tune Switch Password 

Users may restrict tune selection by adding a password to move between tune 
selections to prevent unauthorized switching between tunes 1 to 4.   

Before switching between tune selections, users would need to enter in the 
password (1 to 9999).  If the password is correct, the tune will switch, if it is 
incorrect the tune will not switch.   

It should be noted that not all switching devices may support this function, 
however EFILive's own FlashScan and AutoCal hardware does. 

To enable the tune switch password, users need to input their chosen password in 
the calibration.  As the calibration description states, if the password = 0 then there 
is no password prompt given to the user when switching tunes. 
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V8 Scan and Tune Scan 

Pass-Thru Data Logging  

To log data using FlashScan or AutoCal and V8 Scan and Tune software; 

1. Open the EFILive V8 Scan and Tune. 
2. Connect your FlashScan/AutoCal device to your PC and vehicle. 
3. Turn the vehicle ignition to the On position. 
4. Select an existing Dashboard configuration either by using the [Open Dash] 

button or using the Dashboard drop down, or configure after making controller 
and PID selections. 

5. Navigate to the [F2: Scan] -> [F2: PIDs] menu option. 
6. In the Engine field use the drop down list to select the E98 controller type or 

use Auto Detect. 
7. Drag PIDs or PID folders from the Available PIDs window into the Selected 

PIDs window.  

  

8. Navigate to the [F3: Data], [F4: Charts], [F5: Gauges] or [F6: Maps] tab and 
configure your dashboard to arrange data displays where a dashboard has not 
already been selected. 

9. Users should [Save Dash] to save their custom configurations to reduce future 
configuration requirements.  

10. Start the vehicle. 
11. Select either Record or Monitor from the [F3: Data], [F4: Charts], [F5: Gauges] 

or [F6: Maps] screens.  
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12. Stop the vehicle and turn the ignition off prior to selecting Stop to stop the data 
logging session. 

13. Save the log. 
14. To replay the data log, navigate to the [F3: Data], [F4: Charts], [F5: Gauges] or 

[F6: Maps] tab and select the appropriate Playback buttons. 

 

Pass-Thru Licence and Flash a Controller 

Follow these steps to license and flash the selected controller. 

1. Open the EFILive Scan and Tune application. 
2. Connect your FlashScan/AutoCal to your PC and your vehicle. 
3. Turn the vehicle ignition to the On position, (not the Accessory position.  

Vehicle must not be cranked/running when flashing). 
4. Select the [F3: Tune] option in the left-hand pane. 
5. Click on the Open button and select the calibration file for the controller you 

wish to flash or license.  
6. If tune file security has been applied to the tune file, review and accept the 

Security Warning.  
7. Click on the [F7: Full Flash] options in the left-hand pane.  A full flash is 

required to program a DSP4 into the ECM where a single tune is already 
programmed and to revert from a DSP4 to single tune.  For all other tune file 
flashing please use [F6: Cal-Flash]. 

 
8. Click on the Check License button.  This will indicate if the controller is already 

licensed or needs to be licensed. 
9. Where the controller is NOT licensed, select Activate License to license the 

controller. 
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10. Select Yes to license the controller or No to close this window without licensing 
the controller. 

 

11. Select Yes to license the controller or No to close this window without licensing 
the controller. 

 

12. Select the Full Flash button to commence the flash. 
13. While the ECM is flashing an Elapsed time indicator, an Estimated Time 

Remaining indicator, and a Progress bar will display tracking the Flash 
progress. 

14. When the flash process is complete a countdown timer will be shown.  When 
prompted perform the following actions: 

a. Turn the vehicle ignition Off. 
b. Click on the Start button to begin the countdown timer. 
c. DO NOT turn the vehicle ignition on until the countdown timer expires.  

This time is critical to allow the ECM to perform internal functions after a 
read operation. 
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Configure FlashScan/AutoCal 
for BBX 

 

 

There are a range of configuration files that must be installed on FlashScan and 
AutoCal devices before the device can be used in standalone mode (BBX).   

Follow these instructions to configure your FlashScan or AutoCal for BBX. 

1. Connect your FlashScan or AutoCal to your PC. 
2. Open the EFILive V8 Scan and Tune application. 
3. Select the [F5: BBX] option in the left-hand pane. 

Data Logging 

To configure data logging; 

1. Select the [F2: Scan] option in the left-hand pane. 
2. Remove any unnecessary controller configurations to ensure capacity 

restrictions are not exceeded. 
3. Add your chosen controller(s) to your list; 

a. Press the green '+' icon. 
b. Right click on the Engine Controller box. 
c. Navigate to Select E98. 
d. Select OK. 

  
4. Click on the E98 controller in the “BBL Enabled Controllers” window. 
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5. Navigate and drag the PIDs or PID folders from the Available PIDs window into 
the Selected PIDs window.   

 

Configure Tuning 

To configure flashing of E98 controllers on your FlashScan/AutoCal device; 

1. Select the [F3: Tune] option in the left-hand pane. 
2. Remove any unnecessary controller configurations to ensure capacity 

restrictions are not exceeded. 
3. Add your chosen controller(s) to your list; 

a. Press the green '+' icon. 
b. Right click on the Engine Controller box. 
c. Navigate to Select E98. 
d. Select OK. 

Tune File Switching 

To configure the switching of DSP4 tune positions on your FlashScan/AutoCal 
device;  

1. Select the [F4: Switch] option in the left-hand pane.  
2. Enter switchable tune names as appropriate.  

Configure DTCs 

To configure the display of trouble codes and descriptions onto FlashScan; 

1. Select the [F5: DTC's] option in the left-hand pane. 
2. Select appropriate DTC options. 

Quick Setup 

To configure BBX settings, device settings, and configure tune files for BBX; 

1. Select the [F6: Quick Setup] option in the left-hand pane. 
2. Select appropriate BBX configuration options. 
3. Edit device settings as necessary.  To prevent manually selecting your controller 

PID group each time FlashScan/AutoCal is powered, the most recent PID group 
selection can be automatically selected by: 
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a. Selecting the correct hardware on the [F6: Quick Setup] -> [Edit AutoCal 
V3 Settings] button.   

b. In the Device Settings window, navigate to [F6: Logging] and tick the “At 
start-up, automatically re-select the most recently used PID list.”   

  
4. Add tune files to the Quick Setup using the green '+' icon. 

 
5. Write this configuration to FlashScan or AutoCal using the [Program Quick 

Setup] function.  The [Program Quick Setup] programs all selected Scan, Tune, 
Switch, and DTC options, as well as selected device settings, BBX Quick 
Setup selections and tune files.  Once the device is programmed, FlashScan or 
AutoCal is configured for BBX functions. 

Each option can be programmed individually using the [Program] button on 
each tab, or collectively using the [Program Quick Setup] option. 
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FlashScan Menu Navigation 

 

FlashScan/AutoCal V3 

FlashScan/AutoCal V3 supports two menu structures; the EFILive standard menu 
and the user defined menu.  Where a used defined menu is not installed, the 
EFILive standard menu will be displayed. 

Data Logging 

1. Configure FlashScan/AutoCal V3 for BBX features if not already setup. 
2. Connect your FlashScan/AutoCal V3 device to your vehicle. 
3. Turn the vehicle ignition to the On position. 
4. Navigate to the Scan Tool -> F1 Select PIDs menu option. 
5. Select correct controller type from BBX configured controllers. 
6. Navigate to the F1 Scan Tool -> F2 Data Logging menu option. 
7. Select F1: Record Data to commence the logging session. 
8. The LCD will display recording status, elapsed time, frame count and the 

selected PIDs. 
9. A range of options are available while the Log is recording: 

1. Select ✔ to pause/resume the log. 

2. Select the up and down arrows to navigate through selected PIDs. 
3. Select X, to stop data logging and save the logged data. 

10. Start the vehicle and drive to record actual performance. Do not attempt to 
operate a FlashScan/AutoCal device while your vehicle is in motion. 

11. Select X on FlashScan/AutoCal V3 to stop data logging and save the log file. 

License and Flash a Controller  

1. Configure FlashScan/AutoCal V3 for BBX features if not already setup. 
2. Copy selected tune file(s) from your PC to FlashScan/AutoCal V3 if not 

already copied via Quick Setup during step 1. 
3. Connect your FlashScan/AutoCal V3 device to your vehicle. 
4. Turn the vehicle ignition to the On position, (not the Accessory position.  

Vehicle must not be cranked/running when flashing). 
5. Navigate to the Tune Tool menu and select F1: Tuning -> F3 Program Full 

menu option. 

6. Navigate to the folder your tune file is located in and select ✔ to commence 

the flash. 
7. If the controller has not been licensed by this device previously, you will be 

presented with an “Unlicensed Controller” message. Select ✔ to proceed with 

licensing the controller, or X to exit without licensing the controller. 

8. Select ✔ to confirm licensing the controller and commence the flash, or X to exit 

without licensing the controller. 
9. When the flash process is complete, select X to close the flash completed 

message. 
10. The Reset Controller notification will be shown, and the controller reset process 

will begin. 
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1. Turn the vehicle ignition Off. 
2. Click on the Start button to begin the countdown timer. 
3. DO NOT turn the vehicle ignition on until the countdown timer 

expires.  This time is critical to allow the ECM to perform internal functions 
after a read operation. 

    

    

FlashScan V2 

 Data Logging 

1. Configure FlashScan V2 for BBX features if not already setup.   
2. Connect your FlashScan V2 device to your vehicle. 
3. Turn the vehicle ignition to the On position. 
4. Navigate to the F1 Scan Tool - F1 Select PIDs menu option. 
5. Select correct controller type from BBX configured controllers. 
6. Navigate to the F1 Scan Tool - F2 Data Logging menu option. 
7. Select F1: Record Data to commence the logging session. 
8. The LCD will display the elapsed time, frame count and the selected PIDs. 
9. A range of options are available while the Log is recording: 

1. Select OK to pause/resume the log. 
2. Select F1..F4 or Ctrl+F1..Ctrl+F4 to add “user notes” 1 thru 8 to the log. 
3. Select Enter to toggle between Metric and US Customary units. 
4. Select the up and down arrows to navigate through selected PIDs. 
5. Select Cancel, to stop data logging and save the logged data. 

10. Start the vehicle and drive to record actual performance. Do not attempt to 
operate a FlashScan/AutoCal device while your vehicle is in motion. 

11. Select Cancel on FlashScan V2 to stop data logging and save the log file. 

NOTE: When data logging is activated you cannot return to the menu until 
logging is stopped. 

License and Flash a Controller  

1. Configure FlashScan V2 for BBX features if not already setup. 
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2. Copy selected tune file(s) from your PC to FlashScan V2 if not already copied 
via Quick Setup in step 1. 

3. Connect your FlashScan V2 device to your vehicle. 
4. Turn the vehicle ignition to the On position, (not the Accessory position.  

Vehicle must not be cranked/running when flashing). 
5. Navigate to the F2 Tune Tool -> F1 Tuning and select F3 Program Full menu 

option. 
6. Using the arrow keys, navigate to the correct tune file and select OK. 
7. If the controller has not been licensed by this device previously, you will be 

presented with the License this controller now? message.  Select Yes to 
license the controller or No to exit without licensing the controller. 

8. Select Yes to confirm licensing the controller and commence the flash, or No to 
exit without licensing the controller. 

9. When the flash process is complete the Reset Controller notification will be 
shown.   When prompted perform the following actions: 

a. Turn the vehicle ignition Off. 
b. Click on the Start button to begin the countdown timer. 
c. DO NOT turn the vehicle ignition on until the countdown timer expires.  

This time is critical to allow the ECM to perform internal functions after a 
read operation. 
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Support 

 

Trouble Shooting 

Should users encounter problems with the EFILive software, FlashScan or 
AutoCal hardware they should: 

1. Confirm software, firmware and boot block versions are up to date. 
2. Check that checksums are valid. 
3. Check the base file matches the calibration for your vehicle.   
4. Check to see if the NVRAM in the ECM is functional. 
5. Confirm DSP4 file was upgraded to new operating system number, as 

sequenced above. 
6. Check Voltage settings by monitoring the voltage PID and tune number using 

the EFILive Scan Tool. 
7. Check wiring installation; specifically check that the pins are properly fitted to 

the ECM. 
8. Remove/isolate all after-market devices including mobile phone adapters, after-

market equipment (audio systems, security, remote start etc.) and any devices 
wired into the OBD port that may interfere with vehicle communications. 

9. DO NOT operate any vehicle feature that may communicate on the data bus.  
This includes opening or closing of hood, doors, windows, as well as changing 
settings on radio, HVAC, connecting/removing charging devices etc. 

Error Codes 

If an error occurs while using AutoCal, users can look up the error code 
description in the EFILive V8 Scan and Tune software. 

The [F8: Tools] -> [F8: Error Codes] menu item provides an error code lookup 
function, and the “EFILive Error Codes.pdf” document accessed by selecting the 
Windows Start Icon and navigating to Program Files->EFILive->V8->Documents-
>EFILive Error Codes.pdf is also available.  Both options provide error code 
descriptions, causes and actions. 

Should the issue not be resolved after reviewing the Error code list, end users 
should contact their Tuner for support.  

Checksums 

Checksums perform a vital role in ensuring the integrity of the data in the tune file. 
There are two main reasons that checksums display as invalid: 

1. The data in the file is corrupt and MUST NOT be flashed into a controller. 
2. The data in the file has been modified with a software package that did not 

update the checksums – such as a hex editor. 

Do not correct the checksums unless you know the tune file was modified outside 
of the EFILive software and that the modifications are correct and accurate. 
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If you correct the checksums of a file with corrupt data you are merely masking 
corruption. If you flash a corrupt file into a controller, you risk damaging the 
controller and/or causing the vehicle to operate incorrectly. 

NVRAM Status 

If the NVRAM area of the ECM is corrupted the vehicle may still run, however it 
may not be possible to read or flash the controller.  Typically, if the VIN, Serial 
number, Hardware number and/or calibration ID do not contain valid data, the 
controller will need to be repaired to restore full functionality. 

An error code received during reading and/or flashing may indicate a NVRAM 
issue. 

To identify if the NVRAM is functional or corrupt: 

1. Open the EFILive V8 Scan and Tune software. 
2. Connect your FlashScan/AutoCal device to your PC and vehicle. 
3. Turn the vehicle ignition to the On position. 
4. Navigate to the [F4: OBD] -> [F2: OBD] menu option and select the [Details] 

tab. 
5. Select your controller(s) by using the [Auto Detect] button, or; 

a. Hover over the Engine Controller box, and right click on the “Right-click to 
select engine-controller” box and manually select the ECM. 

b. Navigate and select the correct controller. 
6. Click the [Read] button to populate controller data. 
7. Where the VIN, Serial number, Hardware number and/or calibration ID either 

contain all zeros or non-numeric characters, the controller will need to be 
repaired to restore full functionality. 

 

Controller repair requires the flash memory chip to be replaced in the ECM.  A 
number of companies can perform this service including SoCal Diesel and 
Wait4Me Performance. 

Test for Rogue Modules 

For Customers with FlashScan/AutoCal V3 a range of test modes to check the 
network for rogue modules that may cause read or flash operations to abort are 
available. 

Navigate to the Tune Tool -> F1: Tuning -> F4: Test OBD Network menu. 

Select the Test CAN J1979 option. 
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Trace Files 

V8 Scan and Tune *.htx files  

When V8 Scan and Tune software reads or flashes a controller the details of the 
read/flash process may be saved in trace files for diagnostic purposes. 

In addition, users can manually save trace files where options do not perform the 
desired outcome.   

To manually generate a trace file, generate the error in V8 software, then open the 
EFILive Control Panel and navigate to [F8: Trace] and select [Save Trace].  Users 
can set the trace file and save location during this process.   

Automatically generated trace files are created on your PC or laptop in the folder: 
\Documents\EFILive\V8\Trace and are named using the following naming 
convention: 

YYYYMMDD_HHNNSS_T_CCC.htx, where: 

 YYYYMMDD: is the year, month and day that the trace was recorded. 

 HHNNSS: is the hour, minute and second that the trace was recorded. 

 T: is the mode and is one of R=Read F=Full-Flash W=Cal-Flash. 

 CCC: Is the controller type 

 htx: is the file extension. 

FlashScan/AutoCal V3 *.xalm files  

Trace files are automatically saved where an error message is presented using the 
device in BBX mode.  Users can manually save trace files where options do not 
perform the desired outcome, including for pass-thru functions. 

To manually generate a trace file on FlashScan/AutoCal V3 navigate to Scan Tool 
-> F3: Scan Options -> F1: Save Trace. 

FlashScan/AutoCal V3 maintains an internal buffer of the most recent messages 
sent to and received from the vehicle. That buffer is stored in RAM memory and is 
wiped clean each time the device is powered off or rebooted. Therefore you MUST 
save the trace file before powering off or rebooting the device. 

Trace files are located in the EFILive -> Trace folder on FlashScan/AutoCal V3.  
Trace files are named using the following naming convention: 

yyyymmdd_hhnnss_<desc>.xalm, where: 

 yyyymmdd: is the year, month and day that the trace was recorded. 

 hhnnss: is the hour, minute and second that the trace was recorded. 

 <desc>: is the description where; 
o “User” means user generated trace files  
o “xxx._x_$xxxx” identifies the 3 character controller ID, the 

communication process upload/download, and the 4 digit error code. 

 xalm: is the file extension. 

FlashScan V2 Trace Files 

Trace files are automatically saved where an error message is presented using the 
device in BBX mode.  Users can manually save trace files where options do not 
perform the desired outcome. 

To manually generate a trace file on FlashScan V2 navigate to F1 Scan Tool -> F3 
Scan Options -> F1 Save Trace File. 
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FlashScan V2 maintains an internal buffer of the most recent messages sent to 
and received from the vehicle. That buffer is stored in RAM memory and is wiped 
clean each time the device is powered off or rebooted. Therefore you MUST save 
the trace file before powering off or rebooting the device. 

Trace files are located in the Scan folder on FlashScan V2.  It will be named 
USR_xxxx.efx, where xxxx is the unique file counter number. 

Knowledgebase 

The EFILive Knowledgebase provides a detailed resource on how to configure and 
use your EFILive software and hardware.   

EFILive Authorized Dealer 

If after reviewing this guide further assistance is required please contact the 
EFILive Authorised Dealer from whom you purchased your product. They are your 
first point of contact for EFILive support related inquiries. 

How to Tune? 

EFILive is tuning software and hardware - it is not a tune.  Together the software 
and hardware give users the tools to write tunes.  EFILive does not provide tune 
files, tuning advice or support, but do provide software support and hardware 
support. 

If your question is in relation to the actual tuning of your vehicle (e.g. how to gain 
performance, economy etc.) then please ask these questions on the EFILive 
Forum (http://forum.efilive.com/).   

EFILive Service Desk 

Should you require additional assistance after using this support guide, please 
start a ticket on the EFILive Service Desk.  Please include the following 
information: 

1. Dealer Name. 
2. Device type. 
3. Serial Number and Auth Code. 
4. Your computer operating system. 
5. Software and firmware versions. 
6. Trace files. 

Detailed information about your issue. 

 

https://service.efilive.com/kb
http://forum.efilive.com/
https://service.efilive.com/new-ticket

